An Approach to Geometric Constraint Solving for CAD Representations

Ioannis Fudos, Vicky Stamati and Antonis Protopsaltou
Department of Computer Science
University of Ioannina
GR45110 Ioannina, Greece
fudos@cs.uoi.gr

1. INTRODUCTION
A new generation of CAD systems has become available in which geometric constraints can be defined to determine properties of mechanical parts. The new design concept, often called constraint-based design or design by features [9, 17], offers users the capability of easily defining and modifying a design, but introduces the problem of solving complicated, not always well defined, constraint problems [3]. In this paper, we present the development of a user-friendly interactive system for editing and solving geometric configurations that arise in feature-based CAD/CAM systems. The system is built around a powerful graph-constructive constraint solving method presented in [14], capable of efficiently analyzing certain classes of well-determined, over-determined and under-determined configurations. Minimal systems of geometric constraints that are not solvable by the core constructive method are detected and may either be handled by a numerical method and treated afterwards as rigid bodies, or edited by the user. A main issue pertinent to geometric constraint solving is the solution selection problem. To this end, we have provided an interactive tool for navigating the constraint solver, to the intended solution. Consistent over-determined sub-configurations can be detected, interactively relaxed and solved appropriately. Under-determined subsystems are detected, isolated and subsequently presented to the user annotated with all possible constraint addition choices for interactive editing. To realize the constraint solver we have developed a prototype on a SUN workstation running Solaris 2.5.1. The graphical user interface was built in Java AWT, the core method was implemented in SETL (SET Language) as part of the work described in [5], the extensions for detecting underdetermined and over-determined configurations were also programmed in SETL, and for numerical solving MATLAB packages were invoked.

Section 2 provides an overview of methods for geometric constraint solving, and justifies the selection of the graph-constructive method of [14] for developing an interactive sketcher/solver appropriate for use in CAD / CAM systems. Section 3 briefly outlines the core graph-constructive method used. Section 4 presents the design and development of the graphical user interface, and the basic user interaction and system flow. Section 5 describes our experience with methods for treating over-determined and under-determined constraint configurations and their realization as part of our interactive software. Section 6 offers conclusions.

2. APPROACHES TO GEOMETRIC CONSTRAINT SOLVING
We present an overview of approaches to geometric constraint solving. We outline the most representative methods and evaluate their behavior in terms of the major concerns faced in CAD/CAM systems: solution selection, interactive speed, edit-ability, handling of
over and underconstrained configurations and scope. A first version of this overview was presented in [16].

2.1 Numerical Constraint Solvers
In numerical constraint solvers, the constraints are translated into a system of algebraic equations and are solved using iterative methods. To handle the exponential number of solutions and the large number of parameters, iterative methods require sharp initial guesses. Also, most iterative methods have difficulties handling overconstrained or underconstrained instances. The advantage of these methods is that they have the potential to solve large nonlinear system that may not be solvable using any of the other methods. All existing solvers more or less switch to iterative methods when the given configuration is not solvable by the native method. This fact emphasizes the need for further research in the area of numerical constraint solving.

Sketchpad [31] was the first system to use the method of relaxation as an alternative to propagation. Relaxation is a slow but quite general method. The Newton-Raphson method has been used in various systems [24, 27], and it proved to be faster than relaxation but it has the problem that it may not converge or it may converge to an unwanted solution after a chaotic behavior. For that reason, Juno [24] uses as initial state the sketch interactively drafted by the user. However, Newton-Raphson is so sensitive to the initial guess [4], that the sketch drafted must almost satisfy all constraints prior to constraint solving. A sophisticated use of the Newton-Raphson method was developed in [22], where an improved way for finding the inverse Jacobian matrix is presented. Furthermore, the idea of dividing the matrix of constraints into submatrices as presented in the same work has the potential of providing the user with useful information regarding the constraint structure of the sketch. Though this information is usually quantitative and nonspecific, it may help the user in basic modifications. To check whether a constraint problem is well-constrained, Chyz [10] proposes a preprocessing phase where the graph of constraints is analyzed to check whether a necessary condition is satisfied. The method is however quite expensive in time and it cannot detect all the cases of singularity. An alternative method to Newton-Raphson for geometric constraint solving is homotopy or continuation [2], that is argued in [21] to be more satisfactory in typical situations where Newton-Raphson fails. Homotopy, is global, exhaustive and thus slow when compared to the local and fast Newton's method [23], however it may be more appropriate for CAD/CAM systems when constructive methods fail, since it may return all solutions if designed carefully.

2.2 Constructive Constraint Solvers
This class of constraint solvers is based on the fact that most configurations in an engineering drawing are solvable by ruler, compass and protractor or using other less classical repertoires of construction steps. In these methods the constraints are satisfied in a constructive fashion, which makes the constraint solving process natural for the user and suitable for interactive debugging. There are two main approaches in this direction.

Rule-construcrive Solvers

Rule-construcrive solvers use rewrite rules for the discovery and execution of the construction steps. In this approach, complex constraints can be easily handled, and extensions to the scope of the method are straightforward to incorporate [3]. Although it is a good approach for prototyping and experimentation, the extensive computations involved in the exhaustive searching and matching make it inappropriate for real world applications.

A method that guarantees termination, ruler and compass completeness and uniqueness using the Knuth-Bendix critical pair algorithm is presented in
This method can be proved to confirm theorems that are provable under a given system of axioms [6]. A system based on this method was implemented in Prolog. Aldefeld in [1] uses a forward chaining inference mechanism, where the notion of direction of lines is imposed by introducing additional rules, and thus restricting the solution space. A similar method is presented in [32], where handling of overconstrained and underconstrained problems is given special consideration. Sunde in [30] uses a rule-constructive method but adopts different rules for representing directed and nondirected distances, giving flexibility for dealing with the solution selection problem. In [36], the problem of nonunique solutions is handled by imposing a topological order on three geometric objects. An elaborate description of a complete set of rules for 2D geometric constraint solving can be found in [34]. In their work, the scope of the particular set of rules is characterized. [20] presents an extension of the set of rules of [34], and provides a correctness proof based on the techniques of [13].

**Graph-constructive Solvers**

The graph-constructive approach has two phases. During the first phase the graph of constraints is analyzed and a sequence of construction steps is derived. During the second phase these construction steps are followed to place the geometric elements. These approaches are fast and more methodical. In addition, conclusions characterizing the scope of the method can be easily derived. A major drawback is that as the repertoire of constraints increases the graph-analysis algorithm needs to be modified.

Fitzgerald [12] follows the method of dimensioned trees introduced by Requicha [26]. This method allows only horizontal and vertical distances and it is useful for simple engineering drawings. Todd in [33] first generalized the dimension trees of Requicha. Owen in [25] presents an extension of this principle that includes circularly dimensioned sketches. DCM [11] is a system that uses some extension of Owen's method. [14] presents an elaborative graph-constructive method, with fast analysis and construction algorithms, and extensions for handling classes of nonsolvable, underconstrained and consistently overconstrained configuration.

**2.3 Propagation Methods**

Propagation methods follow the approach met in traditional constraint solving systems. In this approach, the constraints are first translated into a system of equations involving variables and constants. The equations are then represented by an undirected graph which has as nodes the equations, the variables and the constants, and whose edges represent whether a variable or a constant appears in an equation. Subsequently, we try to direct the graph so as to satisfy all the equations starting from the constants. To accomplish this, various propagation techniques have been used but none of them guarantees to derive a solution and at the same time have a reasonable worst case running time. For a review of these methods see [28]. In a sense, the constructive constraint solvers can be thought of as a sub case of the propagation method (fixed geometric elements for constants and variable geometric elements for variables). However, constructive constraint solvers utilize domain specific information to derive more powerful and efficient algorithms.

**2.4 Symbolic Constraint Solvers**

In symbolic solvers, the constraints are transformed to a system of algebraic equations which is solved using methods from algebraic manipulation, such as Grabner basis calculation [8] or Wu's method [35]. Although, these methods are interesting from a theoretical viewpoint, their practical significance is limited, since their time and space complexity is typically exponential or even hyperexponential.
3. A GRAPH CONSTRUCTIVE METHOD

The method is presented in detail in [14]. We provide here a brief outline. A geometric constraint problem is given by a set of points, lines, rays, circles with prescribed radii, line segments and circular arcs, called the geometric elements, along with required relationships of incidence, distance, angle, parallelism, concentricity, tangency, and perpendicularity between any two geometric elements, called the constraints. The problem can be coded as a constraint graph $G = (V, E)$, in which the graph nodes are the geometric elements and the constraints are the graph edges. The edges of the graph are labeled with the values of the distance and angle dimensions. Our constraint solving method first forms a number of rigid bodies\(^1\) with three degrees of freedom, called clusters. For simplicity we will assume that a maximum number of clusters is formed, each cluster consisting of exactly two geometric elements between which there exists a constraint. Three clusters can be combined into a single cluster if they pairwise share a geometric element. Geometrically, the combination corresponds to placing the associated geometric objects with respect to each other so that the given constraints can be satisfied. The constraint solving method works in two conceptual phases.

**Phase 1** (analysis phase): The constraint graph is analyzed and a sequence of constructions is stipulated. Each step in this sequence corresponds to positioning three rigid geometric bodies (clusters) which pairwise share a geometric element (point or line).

**Phase 2** (construction phase): The actual construction of the geometric elements is carried out, in the order determined by Phase 1, by solving certain standard sets of algebraic equations.

![Constraint problem and graph](image)

To illustrate the process, consider three points $A$, $B$, and $C$ between which distances have been prescribed, as shown in Figure 1 left. The associated constraint graph is shown on the right. In Phase 1 of the constraint solving, we determine first that every pair of points can be constructed separately, resulting in three clusters. Moreover, the three clusters can be combined into a single cluster since they share pairwise a geometric element. The combination merges the three clusters into one. As soon as a single cluster is obtained, Phase 1 considers the constraint problem solvable. Phase 1, the analysis phase, consists of two parts:

- the **reduction analysis** that produces a sequence of local cluster merges and handles well-constrained and overconstrained problems, and
- the **decomposition analysis** that produces a sequence of decompositions (that correspond to a reverse sequence of cluster merges) and handles under constrained cases. The outcome of the reduction analysis is fed as input to the decomposition analysis.

4. USER INTERACTION AND SYSTEM FLOW

We have developed a graphical user interface that integrates a geometric constraint solver with an editor for constructing and modifying dimensioned sketches representing CAD cross-sections [9]. For the

---

\(^1\) A rigid body is a set of geometric elements whose position and orientation relative to each other is known.
development of the graphical user interface we used Java's AWT (Advanced Window Toolkit), for three main reasons:

- We were interested in building a rapid prototype to test and tune the effectiveness of our interactive method, Java's AWT provides a relatively easy way for producing graphical user interfaces. Moreover, the new version of AWT has additional flexibility and an improved method for relating user triggered events with actions. These features made AWT a good candidate for developing the GUI of our interactive solver.

- Although executing Java code induces a significant overhead in terms of CPU and memory consumption, this overhead is not noticeable in workstations with sufficient memory.

- Producing Java code makes our graphical user interface portable to the vast majority of platforms.

In Figure 2, a snapshot of the graphical user interface is depicted. The menu for inserting geometric objects and text lays on the right hand side of the main window. At the bottom of this menu above the Exit button there is the the Place Constraint button that transforms the functionality of the right-hand side menu for adding geometric constraints. At the top side there are four pull-down menus. The File menu has the Save/Load functions, and some auxiliary ones such as Merge and Quit. The files contain description of geometric objects, constraints, display information and annotation expressed in a language similar to the one presented in [15]. The communication with the main solver program and the numerical solver is realized through files with the same content augmented with solution specific information from the solver to the user and vice versa. The processing of the files is made possible by translating the high level language to an easy to read list of values, by using a compiler developed in C, using the flex and bison tools.

The View menu hides or makes visible certain classes of objects such as constraints, geometric elements, and annotation. The Edit menu contains the basic Delete, Move and Copy operations which are applicable to both geometric objects and constraints.

The overall user-system interaction is as follows. The user draws a sketch and then imposes constraints on the sketched elements. The user can then invoke the solver which will try to solve the system of geometric constraints and return a new sketch with the geometric elements placed appropriately. If the solver is incapable of solving completely the sketch the user is notified and certain actions may be taken to correct the source of the problem. After successfully solving a dimensioned sketch the user may add/delete geometric objects and constraints, and re-invoke the solver. We have implemented points, circles, rays, lines, line segments and arcs. The available constraints are distance, tangency, angle, coincidence, concentricity and constraints that can be expressed as a combination of the above. We have also included text, for user annotation, in the form of constrained rectangles.
The Solve menu is illustrated in Figure 2. It contains the basic functions for performing geometric constraint solving of the given dimensioned sketch. Figure 3 shows the overall interaction flow for solving a sketch. The user first attempts to solve the sketch by the extended graph-constructive method outlined in Section 3. This is performed by choosing Solve from the Solve menu. If the analysis finds a valid sequence of construction steps for placing all geometric elements, this sequence is followed for producing the final Solved Sketch. However, if the solution does not consist of real numbers, or is not the one intended by the user, an interactive tool may be used for navigating the solver to a meaningful solution. The user is presented with the construction sequence and is given the capability of modifying the relative positioning of the objects involved, thus affecting stepwise the overall solution selection.

Changing the values of some constraints (e.g., distances, angles), of a solved sketch will result in re-evaluating the placement steps (not the graph analysis). When the method cannot solve the configuration, an error message is returned and the user is provided with an enhanced right-hand side menu for interactive intervention. Using this menu, the user may browse the part(s) of the design that correspond(s) to the subgraph(s) that is(are) not solvable. Finding minimal well-constrained subparts is a difficult process that has a worst case time complexity $O(n^4)$ in our implementation. A more sophisticated method $O(n^2)$ has been proposed in [18], but it may need some care to be applied to rigid bodies without spoiling the quadratic complexity. The nonsolvable parts can be edited by deleting and adding constraints and geometric objects. These modifications are incorporated to the overall
design by pressing the Incorporate button at the enhanced right-hand side menu. This drives the design process back to the first step. Currently, the Text, Copy and Move buttons are disabled during the process of editing the nonsolvable parts of the design. Another option for handling nonsolvable parts is to invoke the Numerical Solver for one or more of the nonsolvable parts. If this succeeds, the parts are subsequently treated as rigid bodies. To support this feature we have defined a rigid body structure in the representation language. If the basic solver detects overconstrained or underconstrained configurations it notifies the user. The process for treating such configurations is described in more detail in the next section.

Finally, the user may choose to incrementally edit the solved sketch by adding constraints and geometric elements. Invoking solve in this case tries to incrementally solve the new design. If incremental solving fails, analyzing the overall system of constraints is attempted. Deleting a geometric element or constraint is not considered an incremental change and analysis of the overall graph is attempted.

5. HANDLING OVER AND UNDER-DETERMINED CONFIGURATIONS

Each line or point on the Euclidean plane has two degrees of freedom. Each distance or angle corresponds to one equation. If there are no fixed geometric elements (i.e., geometric elements whose absolute coordinates have been specified explicitly by the user), then we expect that, \(|E| = 2|V| - 3\), where \(|V|\) is the number of geometric elements and \(|E|\) is the number of constraints. This holds for lines and points with distances and angles constraints only. When other objects or constraints exist, we have to substitute with sums for the degrees of freedom and for the constraints. Note that the solution will be a rigid body with three remaining degrees of freedom, because the constraints determine only the relative position of the geometric elements. An example is shown in Figure 4. In the figure, the vertex \(P\) of the quadrilateral has a well-defined position when \(\alpha + \beta = 90^\circ\). But for \(\alpha + \beta \neq 90^\circ\) the position of \(P\) is not determined. This "semantic" notion of well-constrained problems can be made specific for the constraint graph analysis, because there the generic problem of constructing a solution is considered independently of dimension values. Intuitively, a dimensioned sketch is considered to be well-constrained, if it has a finite number of solutions for nondegenerate configurations. Similarly, a dimensioned sketch is considered to be underconstrained, if it has an infinite number of solutions for nondegenerate configurations. Finally, a dimensioned sketch is considered to be overconstrained, if it has no solutions for nondegenerate configurations. The intuitive notions above can be made technically precise for the euclidean plane (see e.g., [13]). For the 3D case, however, the necessary and sufficient conditions for specifying whether a configuration is well-constrained are not known.

![Figure 4. Degenerate Configuration (right) for \(\alpha + \beta = 90^\circ\).](image)

For an algorithm that tests whether a graph is structurally well-constrained in 2D see e.g. [19, 29]. Note that a structurally well-constrained graph can be overconstrained in a geometric sense, for example if there are three lines with pairwise angle constraints. The core reduction analysis handles structurally well-constrained and overconstrained problems. The decomposition analysis handles structurally underconstrained problems. Thus, the graph analysis
may succeed to produce a sequence for placement, even for overconstrained or underconstrained configurations. In any case, the user is notified about the existence of ill-determined configurations. The user may then use the Detect Underconstrained and Detect Overconstrained buttons to analyze the graph. To detect the overconstrained subgraph, the system executes a reduction analysis and keeps track of cluster merging that states the existence of overconstrained configurations. Then, the user is presented with the corresponding part that is overconstrained, after running a simple algorithm that marks constraints that can be candidates for elimination. To detect the underconstrained, the result of the decomposition analysis is run, and the plausible constraint additions are highlighted.

6. CONCLUSIONS

We have presented an overview of approaches to geometric constraint solving and selected a powerful graph-constructive method for building around it an interactive system for designing and solving dimensioned sketches. We have presented an innovative paradigm of user interaction for using the core method, treating ill-determined configurations, handling nonsolvable cases and performing solution selection. We have developed a prototype to evaluate this paradigm and to fine tune the system-user interaction.

7. ACKNOWLEDGMENTS

This work is supported by a Research Grant (PENED – 01ED329) by the General Secretariat of Research and Technology, Greece.

8. REFERENCES


Theorem Proving in Elementary Geometries. Journal

[36] Yasushi Yamaguchi and Fumihiko Kimura. A
constraint modeling system for variational geometry.
In M. J. Wozny, J. U. Turner, and K. Preiss, editors,
Geometric Modeling for Product Engineering, pages
221-233. Elsevier Science Publishers B.V. (North
Holland), 1990.